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1 Introduction

Le Microsoft PowerPoint est un logiciel créé par la société Microsoft vers les années

Ce logiciel permet de créer une présentation pour écran et vidéo projecteur (un
diaporama). Il est utilisé pour les présentations commerciales et techniques lors de
réunions et pour les présentations lors de conférences ou pour donner des cours.

PowerPoint inclut finalement deux parties : un mode conception de diapositives et un
mode diaporama qui permet d'afficher la présentation. Chaque présentation est
composeée de différentes diapositives affichées les unes aprées les autres.

L’extension des fichiers crées par PowerPoint est .ppt (exemple : nomfich.ppt).

2 La fenétre PowerPoint
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Figure 1
1. La barre de titre Windows et affiche le titre de la présentation en cours.
2. Les menus de PowerPoint ne sont pas différents dans leur structure de ceux

des autres applications Microsoft Office (Word, Excel, ..).

3. Les barres d'outils. Le choix des barres affichées est sélectionnable dans le
menu Affichage -> Barre d'oultils.

4. Régle. Ici aussi une option du menu affichage.



Le mode d’affichage : normal, mode trieuse ou diaporama. Ee=

La diapositive. C'est dans cet espace que nous allons créer et modifier nos
diapositives.

7. Le volet office. Cet affichage est spécifiques aux versions XP et 2003. Il est lui
méme divisé en plusieurs parties.

oo

3 Creéation de notre premier diaporama avec PowerPoi  nt

Pour créer votre premier diaporama (il y a des versions du PowerPoint qui crée
automatiquement un diaporama apres le lancement de ce dernier), tu peut choisir

'une des trois fagons suivantes :

» Cliquer dans la barre d’outils sur i = E ricone de la page blanche.

* Taper <CTRL>+N .

» Aller dans Menu ->Fichier ensuite cliquer sur Nouveau , ceci affichera I'écran
suivant :

Microsoft PowerPoint

|3 mouvelle présentation
& partir du modéle de conception
@ & partir de 'Sssistant Sommaire aL
@ C_T-é'a_r & partir d'une présentation €
&lburn phata, ..
Modéles
Rechercher en ligne

=

Fﬁ Modéles sur Office Online
Sur mon ordinakeur, ..
[ Sur mes sites Web, .,

Modeles récemment utilisés
Fusian.pot

Figure 2

Si vous cliquer sur A partir de I'’Assistant Sommaire automatique,  un guide ou un
assistant vous guidera pour créer votre diaporama selon le type de votre
présentation (Formation professionnelle, commerciale, etc).



La meilleur facon et de créer votre propre présentation et ceci en cliquant sur
Nouvelle présentation. Ceci vous donnera le choix de choisir une mise en page des
diapositives selon la fenétre suivante :

Tapez une question ;
A - | o conception | Mougelle dispositive &
Appliguer la mise en page des
diapositives :
Disposition du texte. —
Disposition du contenu:
................................................................ 2
il =
-] BLES
[ o L
. : - = b
- Lz podr apenter des camima sl Iv afficher lors de linsertion de nouvelles diapa
[Eea= ||| 7 -
Digpositive 1 sur 1 Modéle par defaut Fr:én;ais (France) Y
Figure 3
Vous choisissez une mise en page selon le type de votre présentation.
m Graphe p— Titre et sous titre
g Image Clipart - Zone de texte
Tableau

Automatiquement, la premiére diapositive du diaporama PowerPoint est de type:

Ceci correspond a la mise en page de diapositive suivant:



...............................................................

Pour voir les différentes fonctionnalités du PowerPoint, on va travailler sur une
présentation d’'un cours d’'informatique sur I'architecture de I'ordinateur. La premiéere
étape est de remplir les deux champs : on va rentrer comme titre « Initiation a
I'informatique » et comme sous titre « Architecture des ordinateurs ».

Initiation a l'informatique

Architecture des ardinateurs

Ensuite Ajouter une nouvelle diapositive par la barre d'outils Mise en forme en
cliquant sur :

—Iheurelle dispositive o ooisir la mise en page des diapositives, on va choisir par

exemple :



Cliquez pour ajouter un titre Plan de l'exposé

'+ Cliquez pour ajouter dutexte + Introduction
i ’ + Composantes principales de I'ordinateur
+ aic.

Pour la mise en forme du texte, on suit les mémes étapes déja citées dans le cours
du Word. De méme pour l'insertion des objets (images, tableaux, etc).

Dans ce cours, on va présenter seulement les nouvelles fonctionnalités (existant soit
dans le Menu principal ou dans la barre d’outils) du PowerPoint qui n’existent pas sur
Word ou Excel.

4 Les nouvelles fonctions du PowerPoint dans le men u

Les commandes présentées dans cette paragrapbawsnt dans le menu principal du
PowerPoint (Fichier, Edition, Affichage, Insertidrgrmat,...).

SR

@ Mictosoft PowesPoin - [PowerPoint ppt]

4.1 Affichage :
= Trieur de diapositive permet d’afficher toutes les diapositives dames seule page.
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Figure 4

+ Diaporama (F5): permet de donner une visualisation en pleinréetde défilement
des diapositives I'une aprés l'autre en s’appugantEntrer ou sur le bouton gauche
de la souris. Dans l'affichage en plein écran \enexz la possibilité de travailler avec

un marqueur (sous forme d’un stylo), vous cliquaz “ et choisissez ensuite
le type de marqueur que vous voulez : stylet pointe bille, stylet feutre, etc.
Vous pouvez annuler ce que vous avez fait avec ce marqueur en utilisant la
Gomme (Figure 5).

+ Page de commentaire permet de donner I'affichage du diapositive plus son
commentaire.

+ Barre d'outils permet d’ajouter et d’'afficher des outils dans la page principale
du PowerPoint.

+ Afficher I'orientation  permet de changer I'orientation

+ En-téte et pied de page permet d’'afficher des informations en téte et en pied
de page (Figure 6).



- Dans I'affichage en plein eécran vous avez
la possibilite de travailler avec un
marqueur (sous forme d’un stylo), vous
cliquez s et choisissez ensuite le type

eur que vous voulez : stylet

ille, stylet feutre, etc. Vous pouvez

r ce que vous avez fait avec ce

margueur en utilisant la Gomme.

yousfi Abdellah, Université
0 Mohamed V, souissi. Rabat

Figure 5

Diapositive | Commentaires et documents

Inclure dans la diapositive appliquer parkout |
v Date et heure
{* Mise 4 jour automatique RIS |
03/ 10/2006 w annuler |
Langue :
Frangais (France) w
{" Fixe Apercu

[ Muréro de diapositive
[v Pied de page

wousfi sbdellah, Université Mobhamed ¥, souissi, Rabat ST '

[v Me pas afficher sur la diapositive de titre

Figure 6

Ceci affichera « yousfi Abdellah, Université Mohamed V, souissi, Rabat » plus la date
en pied de page.

4.2 Insertion :

+ Caracteres spéciauxil permet d’'insérer des caracteres spéciauxguigurent pas
sous le clavier (Figure 7).



f 0

Police : [(texte normal) v|  Sous-ensemble : [Latin tendu-a -
AN[nIN|{An|N|n[O|d|0|6|0*°
RIFIR|TIR[F|S|s|S|a|S|s|S
TIt|F|¢|0|a|0Ojajulalu|alu
WWw[Yy|Y|Zlz[Zz[z[Z]|z]T]o.

Caractéres spériaw récemment utilisés :

"IEIL|¥|©O® ™M |F|s|z|F|x|®|M|lA

Code du caractére ; 0141 de |Llni|:|:u:|e (hexadécimal) j
Insérer | annuler |

Figure 7

+ Commentaire: avec cette commande vous pouvez insérer un camiredans une
diapositive et I'associer a un objet (mot, imagde) existant sur cette diapositive.

diaporama :

1e des trois fat;ons;
» (page blanche)

oA

—d

=

MAG est un commentaire associé a I'imalgs, que vous mettrez le pointeur de la
souris sur MAG, le commentaire s’afficnelans une zone de texte

+ Diapositives a partir d’un fichier. si vous avez une diapositive sur un fichierais/
voulez l'insérer dans un autre fichier de PowerBailors il suffit de cliquer sur cette
commande pour obtenir la boite figurant dans Fig@urénsuite vous choisissez
d’abord le fichier contenant cette diapositive espvous sélectionner la diapositive
gue vous voulez I'insérer (Figure 8).
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Rechercher la présentation l Liste des Favaris ]

Fichier : |D:'I,D.':'.T.':'.'I,CDLIFS'I,EEDHI:I'I,'IJ'I.I'I:IrIj'I,II'Iitiatil:ll'l au Microsoft 'u'-.-'u:uru:l.p|:| Parcoutit.. .

Ajouker aux Faworis |

i SRl
Sélectionnez des diapositives : = I

ik ai HE ol cd Weard P omarislier Mo e S
Vi all s gl s sl bl

T
--:.I'.hl:-i-l.rrlill‘lll

e S P u . ) I

|1. Initiakion au Microsoft ”2 Présentation de [&cran du || |
[ Conserver la mise en forme d'origine Insérer | Touk insérer | Fermer |
Figure 8

+ \ous pouvez insérer une image soit a partir d’ahiéir ou a partir de la bibliotheque
des cliparts de I'office en cliquant sur insertetrchoisissez Image. Ensuite vous
choisissez le fichier contenant I'image a partidésque dur.

+ Insertion->Image->Organigramme hiérarchiquela validation de cette choix dans le

menu principal du PowerPoint donne un organigraravee plusieurs zones de textes
qui doivent étre remplisses.

Cllquez poLr

ajouter du texte gjouter du texte

ajouter du texte

Cllquez pour
ajcuuter du texte

[ Cllquez poLr ] [ Cllquez pour

Vous pouvez ajouter des éléments @&waiganigramme en utilisant la boite a outils
Suivante :

Organigramme hiérarchique - X

i = Insérer une forme - Mise en forme -

. . )
Sélectionner -~ | %1

4+ Vous pouvez aussi insérer un sons soit a parta téliotheque multimédia soit a
partir d’'un fichier audidnsertion->Films et SonsDe méme vous pouvez insérer un
film sur votre diapositive de la méme facon.
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=+ Insertion->Liens hepertext@ous permis d’insérer un lien hepertexte sur votre
diapositive soit vers un autre diapositive ou en Ners un autre fichier. Ceci vous
donnera la boite suivante :

Insérer un lien hypertexte

Lien hypertexte  Texte & afficher : [Ceci est un lien vers e diapositive 2 Info-bulle. .. |
Fichu:uu Sélectionner un emplacement dans ce document ;. Apercu de la diapositive :
page Web -~ Premiére diapositive
existant(e) - Dernigre diapositive
- Diapositive suivante
Emplacement D.|a|:u35|twe Frece.dlente « Doapirn 2
e @z =) Titres des diapositives
document 1. Diapositive 1
i 2, Diapositive 2
)iﬁ - Diaporamas personnalisés
Créer un
docurent
™ afficher et revenir
Adresse de
messagens (4 I annuler
4.3 Format :

+ Format->Conception de diapositiweous permis de choisir un modeéle de conception
pour vos diapositives. Ceci affichera une barreoiteldu fenétre PowerPoint. Cette
barre vous permis aussi de changer le jeux de wsuét le jeux d’animations.

Le choix de ce
modeéle donne
des diapositives
sous la forme

figure (Figure 9)
W

Tapez une question

- B

Jisis A == Ao B

présentée dans la

§Enmces.tiun.des.diagiusitiues. b
e I

&=l Modéles de conception
L==t Jeux de couleurs

b L]

5k Jeux d'animations

Appliquer un modéle de conception :

Utilisé{s) dans cette présentation

T e

12
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Université Mohamed V souissi

s Faculté d’economie rabat
s ENSIAS

= ENSIA

Figure 9

4+ Format->Mise en page des diapositivegermet de choisir la mise en page d’'une

diapositive. Ceci affichera le volet suivant lidraite de la fenétre principale du
PowerPoint

- [= ][]
Tapez une quesktion -

sl iz lAlE=EElAC o M
Mise en page des diapositives v

@ || »

Appliguer la mise en page des
diapositives :

Disposition du texte S

Le choix de cette
mise en page

donne ce qui est
présenté dans la

F|gure 10 \ S Hiel | Hihe
Disposition du contenu
EHE S
(11 I
BHE = HE|EBHS
bl =73 s
D FEA ==
I =Y Y| EL e
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éCquuez pour ajouter un titre

3 [ 8l
R
Cliquez pour ajouter un
s contenu
&
Cliquez pour ajouter =TT
un contenu R

Cliquez pour ajouter un
contenu

Figure 10

#+ Vous pouvez aussi appliquer une arriére plan suesovos diapositives en cliquant
surFormat-> Arriere-plan.Ceci donne la boite suivante qui permet de chaisir
couleur pour votre arriére plan (dans cet exempla ohoisi la couleur jaune)

Remplissage de l'arrigre-plan appliguer partout |

& .
Tikre Appliquer |

+ Puces
- ﬂ Annuler |
Apercu |

| =l
| Cacher les graphigues du masque

+ Format->Espace réservépermet de définir I'arriere plan et I'angle deatidn ainsi
les marges de la zone de texte qui existe suafzoditive (Figure 11)

14



5 Disporama  Fenétre 2

Couleurs et kraits  Taille | Position ] | Zoredstexts | Wweb |

Taille et rotation

Hauteur ; 1418? I _% Largedr |1?J?'9 o 3:

R.okatiarn : 10® =

Echelle

Hauteur ; 100 . j Largeur |1|:||:| U il]

[ Proportionnele
-
-

CI i q u G‘ Taille initiale

Haukewur : Largeur : =i

T —

Figure 11.

4.4 Diaporama :

+ Diaporama->Visionner le diaporamau F5 : permet de visionner votre présentation
en plein écran.

+ Diaporama->Vérification du minutage permet d’afficher un compteur ou un
chronomeétre lors de votre présentation pour pouixar le temps de la présentation
de chaque diapositive. Ensuite vous avez le chegadivegarder le temps de chaque
diapositive. Le sauvegarde de ce temps permetmuiite une présentation
automatique selon ce temps sauvegardé. Pour arnatleropération, allez dans
Diaporama->Parametres du diaporamet cochez la caddanuel dans Défilement
des diapositives, comme il est présenté sur lar&igA :

15



Paramétres du diaporama

—Type de diaporama —Diapositives
¥ Présenté par un présentateur {plein écran) * Toutes
™ Wisionné par une personne (fendtre) i De: I—g Ao I—E
™ Afficher |2 barre de défilement " Diaporama persornalis ;

£ Wisionné sur une borne (plein écran) | |

— Options du diaporama —Défilement des diapositives
[ Exécuter en conkinu jusqu'd ECHAP (+" Manuel
[~ Diaporama sans narration 7 Utiliser le minutage existant
[ Diaporama sans animation — Plusiewrs monikeurs

afficher e diaporama sur

Couleur du styio : | —— | [Moriteur principal |

I [ Mode Présentateur
—Performances
[ Utiliser 'accélération graphique matérielle Conseils |
Fé&salution du diaparama : |[thi|iser la résolution en cours) w |
QK | annuler |
Figure 12.

+ Diaporama->Boutons d’action permet d’insérer un bouton sur votre diapositive
bouton est associé a une action (exécution d’imeficcréer un lien vers un
diapositive appartenant & un diaporama, lien hggeat etc) (Figure 12). Vous pouvez
ajouter a votre action un sons.

+ Diaporama->Jeux d’animations :vous permis de choisir une animation pour votre
diapositive. Ceci affichera une barre a droite ehétre PowerPoint. Cette barre vous
permis aussi de choisir les jeux d’animations (FedLB).
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Paramétres des actions |X

Cliquer avec la souris | Painter avec la souris |

Action suite & un clic

 Aucune

% Créer un lien hypertexte vers

| Diapositive suivante h |

" Exécuter le programme

| DhiGraphicsicapturelicapture. exe Parcourit, . . |

" Exécuter la macro |

" Action OLE :
3 [ activer un son r
| [Aucun son] |
¥ animer e clic
o 4 Annuler |
Figure 12
Enncestinn des diaﬂositives b 4
Modéles de conception
[=2t Jeux de couleurs
=% Jeux d'animations
La liste de jeux Appliquer aux diapositives
, . . seélectionnées :
d’animations

utilisé(s) récemment

>

Balavage

\ Montée

Apparition et estompage
Apparition

Sans animakion

Discrek

parition
Apgparition et estompage =
Fondu général
Fondu un par un
Fondu estompé
Fondu en balayage
Fondu et zoom
Appliquer le souligneé
Dissolution au début
Armpoule de Flash
Mise en &vidence

[ L T R

Figure 13.
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. . o . s Ajout Fret "
4 Diaporama->Personnaliser I'animation cliquez sul* T 71 et choisir

I'effet d’animation que vous voulez I'associer a votre objet inséré sur le
diapositive (Figure 14) :

Les effets K Owerre |3 1 spparaite
d’animation

par groupe \ Emphase b | 3¢ 2. Damier
Fermetre P | 3% 3. Encadré

ajectoires »
*-n-—.—

\'ﬁk
T

4. Entrée brusgue

r

% 5 Losange

S 6 Stores
Autres effets...

Figure 14.

L’animation se définie également par sa vitesse et la maniére d’enchainer avec la
précédente. Le choix de ces parametres se fait en cliquant sur la boite suivante :

[ 3-8 3k aide les autres EI
Demarrer en cliquant

Demarrer avec le precedent

D Demarrer gprés le précédent
Cptions d'effet...
Minutage. ..
afficher la chronologie avancée

Supprimer

+ Diaporama->Transition :1l permet d’enchainer les diapositives entre elles par
des effets de transition (Figure).
Si vous cliquez sur "Appliquer a toutes les diapositives " toutes les
diapositives vont s'enchainer de la méme maniére.
Pour faire une transition différente a chaque diapo, passez en mode trieuse :
sur chaque diapositive avec le bouton droit de la souris, validez la transition
dans le menu contextuel,
Sous chaque diapositive s'affiche si la transition existe et le temps si elle n'est
pas manuelle.

+ Diaporama->Diaporama personnalisé : il permet a partir d’'un diaporama
existant, de créer d'autres diaporamas personnalisés.
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: Transition v

Appliquer aux diapositives
sélectionnées :

Sans transition

3

Yolet horizonkal

Yolet wertical

Découvriv vers l'inkérieur
Découyriv wers 'exbérieur
Dramier vertical

Damier horizonkal
Bandes horizontales

Bandes verticales

Recouvriv & parkir du haut

Recouvriv & partir de la droite
Recouvriv & parkir de la gauche
Recouvtiv & parkir du bas

Recouyvriv & partir de la droite en haut

Recouvriv & partir de la draoite en bas

w
Modifier la transition
Witesse |F'\-flli'i'2|E | "’|
San |[.ﬁ.ucun son] | - |

=

Passer a la diapositive suivante

[v Manuellement

v Aukomatiquement aprés |00:02,5 3:
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